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The Electronic Structure of Molecules - An Introduction to Computational 
Methods and Molecular Orbital Theory 

 
Adapted from S.F. Sontum, S. Walstrum, and K. Jewett 

 
PRELAB:  
 
1. Reading: Chapter 9, sections 7-8 of your textbook. 
 
2. Draw the Lewis Dot structures for H2, HF, LiH, O2 and NO.  If a compound is polar, and add a vector arrow to 
your drawing that indicates the molecular dipole. 
 
 
Introduction to Gaussian using WebMo 
 

 
 
The molecule, above, is an anti-HIV protease inhibitor that was developed at Abbot Laboratories, Inc. Modeling of 
molecular structures has been instrumental in the design of new drug molecules like these inhibitors. The molecular 
model kits you used last week are very useful for visualizing chemical structures, but they do not give the 
quantitative information needed to design and build new molecules. Gaussian is another "modeling kit" that we use 
to augment our information about molecules, visualize the molecules, and give us quantitative information about the 
structure of molecules. Gaussian calculates the molecular orbitals and energies for molecules. If the calculation is set 
to "Geometry Optimization," Gaussian will also vary the bond lengths and angles to find the lowest possible energy 
for your molecule. Gaussian is a text-only program. A “front-end” program is necessary to set-up the input files for 
Gaussian and to visualize the results. We will use the WebMo program as a graphical “front-end” for Gaussian. In 
other words WebMO doesn’t do the calculations, but rather acts as a go-between you and the computational 
package. 
   In terms of "good-better-best" for the models that we use to understand molecular structure, Lewis Structures are 
"good," molecular mechanics calculations are "better," and molecular orbital calculations are "best." Among the 
molecular orbital approaches themselves, semi-empirical-PM3 is "good," Hartree Fock 3-21G(*) is "better," and 
higher levels including 6-31G* are even better. (You will learn more about the different levels of molecular orbital 
calculations if you go on in chemistry.) 
 
Electron Surfaces 
 

A useful way to visualize the results of a molecular orbital calculation is to look at the total electron density. 
Electron density plots at low contour levels (0.002), called density surfaces or size density surfaces, can be used to 
see the size of molecules. These plots are more realistic than using Van der Waals radii and space-filling models. 
Higher contour values (0.08), called bond density surfaces, can be used to understand bonding interactions. Bond 
density surfaces show the increase or decrease of electron density between the atoms in bonds.  

 
Figure 1: Bond density surfaces.  Left: 87% ionic LiF.  Right: 100% covalent F2 

Li F F F 
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Molecular orbital surfaces can be viewed 
to understand how atomic orbitals overlap 
to make molecular orbitals. Better overlap 
makes for stronger bonding. To judge if 
an orbital is sigma or pi type, we look at 
the direction of overlap of the p orbitals 
on the two atoms, Figure 2. Sigma bonds 
are usually stronger because the atomic p-
orbitals point towards each other and have 
better overlap. For double bonds, the first 
bond is sigma type and the second bond is 
pi-type. 
 
When two atomic orbitals overlap, two 
molecular orbitals are formed. One of the 
molecular orbitals is bonding and the 
second is anti-bonding. Bonding 
molecular orbitals increase the electron 
density between the two nuclei, while 
anti-bonding orbitals decrease the electron 
density between the two nuclei. The trick 

to strong bonding is to have a configuration 
with many bonding electrons and few anti-
bonding electrons. 
 
Molecular orbital surfaces are very useful 
for visualizing the difference between 
bonding and anti-bonding orbitals. Figure 3 
shows the “cartoon” of a bonding and anti-
bonding orbital, along side the 
corresponding accurate MO surfaces. The 
trick to determining bonding or anti-
bonding behavior is to look at the phases, 
or colors, of the orbitals in the overlap 
region. A change in sign of the orbital 
between the two nuclei signifies an anti-
bonding orbital. 
 
Often, the highest occupied molecular 
orbital, or HOMO, and the lowest 
unoccupied molecular orbital, or LUMO 
are the dominant factors in determining the 
chemical reactivity of a substance. We will 
visualize the HOMO and LUMO for O2. 
You should be able to predict the nature of 
the HOMO and LUMO from molecular 
orbital theory. Based on your discussion of 
molecular orbital diagrams in lecture, are 
the HOMO and LUMO sigma or pi type, 
bonding or anti-bonding? 
 
 
 
 
 

π∗ 

π 

σ∗ 

σ 

Figure 3: Bonding and anti-bonding (*) 
orbitals 

Figure 2: Pi-type (top) and Sigma type (bottom) 
molecular orbitals 
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Part I: Polar Covalent Bonds and Molecular Interactions1 

 

Introduction 

   Two things are needed for a molecule to have a dipole moment: polar bonds and an unsymmetrical shape. For 
example, homonuclear diatomic molecules like H2 and O2 can't have a dipole moment because the two atoms are 
identical and the bond will be 100% covalent. Other examples are C-H bonds, which are not normally significantly 
polar. Compounds with only C and H have very small dipole moments if any. C-Cl bonds are very polar but CCl4 
has no dipole moment, because this tetrahedral molecule is too symmetrical and the bond dipoles cancel out, Figure 
4. The presence of a molecular dipole moment has a big effect on the properties of molecules and their reactivity. 
For example, the boiling point of a polar liquid is much higher than the boiling point of a non-polar liquid with a 
comparable molecular weight. 

 
Figure 4. Cancellation of bond dipoles in a tetrahedral molecule. 

 
   Polarity effects are sometimes difficult to visualize. Electron density plots and electrostatic potential surfaces can 
be very helpful in visualizing these effects.2 Electron density plots tell you where the electrons are in a molecule. 
Electrostatic potential surfaces tell you if the electron density is skewed from the distribution in the neutral isolated 
atoms. The electrostatic potential is calculated by the energy of interaction between the molecule and an imaginary 
point charge. The point charge is a single positive charge and corresponds to the potential energy a H+ ion would 
see. The point charge is moved around on the electron density surface, so the potential is mapped for a constant 
value of the electron density. Some examples will be useful and easier to grasp than the description of the 
calculation itself. We will first look at the electron density surfaces for H2, HF, and LiH. 
   As you generate these surfaces look at the distance from the nucleus of each atom to the surface. The greater this 
distance, or in other words the bigger the surface, the more electron density surrounds the atom. Also look at the size 
of the density surface along the internuclear axis between the two nuclei. This internuclear area is where electron 
density must build for a strong bond to form. Red coloring from the electrostatic potential means that the net charge 
in that area of the molecule is negative. That is, a red color shows that the atom is surrounded by more electrons than 
it would have in a neutral atom. Blue coloring shows a positive net charge. A purely covalent bond, such as in H2, 
should not show any skewing of electron density and should be uniformly colored. 
 
Building H2, HF, and LiH 
 
1)  Open the desktop in Safari, then you can access WebMo using the URL: “http://schupflab”. Log in using the 
class account clearly labeled on your computer. Record this class account in your lab notebook. Go to “New Job” 
and click on the option to “Create New Job.” In the WebMO Editor window, draw your molecule. As an example, 
the instructions below are for HF. You can build other molecules in a very similar fashion. 

i) Click on the Build icon: . Click in the Editor window to create the first atom. Then starting at the first 
atom drag the mouse to the right to create the second atom. The default element is carbon, so the next step 
is to change the atoms to hydrogen and fluorine. 

ii) Click on the periodic table icon: . Now click on F in the table and then one of the atoms in the Editor 
window. You should see that atom turn green. Next click on H in the periodic table and then the second 
atom in the Editor window. That atom should be smaller in size and white in appearance.  

If you make a mistake, there is an Undo option under the Edit menu, or pull down the File menu and 
choose New to begin, again. 

iii) Pull down the “Clean-Up” menu and choose “Comprehensive- Mechanics” to adjust the bond length to a 
reasonable guess.  
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These guesses are derived from bond length tables. This minimization is a very rough guess of the 
molecular structure. 

 

Now click on the “blue arrow” button (found at lower right corner of the Editor window) the bottom-right of the 
editor window to close the “Editor” window. 

 
Running a Molecular Orbital Calculation 
 

2)  Under the “Choose Computational Engine” page, choose “Gaussian” (if not already selected). Click the blue 
arrow button. You should now be on the “Configure Gaussian Job Options” page. Type in a unique name for 
the “Job Name” and choose the following options (see figure below):  

 Calculation: Geometry Optimization 
Theory: Hartree-Fock 
Basis Set: Routine: 6-31G(d) 
Charge: 0 
Multiplicity: Singlet 

 

 
 

For the multiplicity for other molecules, use Hund's rule or your Lewis dot structure to decide the number of 
unpaired electrons. If all the electrons are spin-paired use singlet (most molecules are diamagnetic singlets). If 
there is one unpaired electron as in NO use doublet (most radicals are doublets), if there are two unpaired 
electrons, as in O2, use triplet (oxygen is a paramagnetic triplet). 

 
3)  Click on the blue arrow button, to start the calculation. The screen will switch back to the “Job Manager” screen. 

After less than a minute the “Status” of your calculation should change to a green colored “Complete”. Click on 
the magnifying glass icon to see the results. You can rotate your model now by using the mouse. To change the 
size of the molecule you click on the magnifying lens and hold the mouse clicked down while dragging it away 
from you or towards you. Make a sketch of the molecule and label each atom. 

 

4)  Scroll down the “View Job” window until you see a “Calculated Quantities” window. Record the energy value 
with unit. The value is listed as “RHF Energy”(restricted Hartree Fock). For the energy units 1 au = 1 Hartree = 
2625.5 kJ/mol, which is twice the energy of the hydrogen atom. Since 1 Hartree = 2625.5 kJ/mol, small differences 
in energy in atomic units are large differences in kJ/mol. For molecules with unpaired electrons, the final energy 
will be labeled as the “UHF Energy”(unrestricted Hartree Fock). Record the “Dipole Moment” value and unit. 
Click on the icon of the magnifying glass adjacent to the “Dipole Moment” value. The dipole moment vector will be 
displayed in the “Molecule Viewer” window at the top of the page.  
 
Draw this dipole onto your sketch (from step 3). Is the dipole in the direction that you predicted? Is the dipole in 
agreement with the electrostatic potential surface and the partial charges?  
 
Record the “Partial Charges” on each atom as given in the “Calculated Quantities” window. 
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5)   Scroll back up to the “View Job” window to measure the bond length. Click on the “Select”  icon. Since there 
are only two atoms, the bond length will be listed at the bottom of the “View Job” window, automatically. 
Record this bond length and unit. For larger molecules, click and then shift-click on pairs of atoms to determine 

the distances. To see 3-D rotation of the molecule, click on the “Rotate” icon: . 
 

       If you have a triatomic or larger molecule, measure the bond angles by choosing the  icon. Then click and 
then shift-click on the three atoms whose bond angle you desire. Record this data, and return to 3-D rotation as 
before. 

 

6)   Click on the “Preferences”  icon. Choose how you want to see your model  by changing the “Atom Size” 
and/or “Bond Size” values. Try 20% and 20% to view a ball and stick model. Try 100% and 100% to view a 
space filling model (often called Van der Waals). The "sizes" of the atoms in this type of display are only 
suggestive of the size and shape of the molecule, and will not vary with the true electron density around the 
atom.Leave the molecule in the Ball and Spoke form with the default values of 20% Atom size and 100% Bond 
size. Click on the blue arrow button to return to the Job Manager. 

 
7) Return to step one of this hand-out to begin to Build and Clean-up H2.  Then  repeat the process for LiH. Use the 

same “Job Options” as for HF, for each of these molecules and complete steps 1-5. Record the RHF energy and 
the bond length, of each. 

 
Electron Density and Electrostatic Potential Surfaces 

To get a much better representation of the size of the molecular orbitals, you use a density surface. Open 
each molecule in turn and repeat the following instructions. To view different molecules, from the “Job 
Manager”, click on the corresponding magnifying glass icon. 

 

8)  View a molecule in the “View Job” window and then scroll down to the bottom of that window to click on “New 
Job  Using This Geometry” button. Click on the blue right arrow button twice. You should now be in the “Choose 
Computational Engine” window. Again, click on the blue right arrow. Choose the following options:  
 Calculation: Molecular Orbitals 

Theory: Hartree-Fock 
Basis Set: Routine: 6-31G(d) 
Charge: 0 
Multiplicity: Singlet 
 

 
 

Complete the calculation as you did before. View the new results by clicking on the corresponding magnifying 
glass icon once “Status” is complete. Before you do this next step you want to be sure that any non-WebMO 
tabs on the desktop are closed to help the loading applet be more successful. If a window pops up asking your 
permission to access applets you need to click on the  “Allow”  or “Trust” button. 
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9)  Scroll down to “Calculated Quantities” until you see the “Molecular Orbitals” window. Click on the magnifying 
glass icon for “Electron Density” and wait.  

 
 

After a few seconds (during which a Java applet will be loaded) the “Molecule Viewer” will switch to the 
Molecular Orbital Viewer mode automatically, up at the top of the page. The electron density surface should be 
displayed. You can reorient the surface using the mouse. To change the size of the molecule displayed you need 
to hold down the Shift key (on keyboard) while holding the mouse clicked down and dragging the mouse 
towards/away from you. 

 

10)  Using Electron Density Surfaces to Compare the Bonding in HF, H2, and LiH:  

Click the “Preferences”  icon. A window should pop up with an Opacity sliding bar. Move the slider to 67%. 
Click on the “Apply” button. Note the position of the H atom(s), relative to the surface. The default value for the 
isodensity surface corresponds to roughly a 90% contour surface. The 90% contour surface provides a visualization 
of the shape and size of a molecule, as seen by other nearby molecules. Iso-value electron density surfaces are more 
realistic than “space-filling” models. However, to see the effects of electron sharing from bond formation, we need 
to choose a higher iso-value so that we can focus on the high-electron density portions of the molecular orbital. 
 

11)  Click on the “Preferences”   icon, again. This time change the Iso. Value(ED) setting to 0.05, and then 
click on “ Apply” button. The electron density surface will be redrawn to highlight the regions of the molecular 
orbital with high electron density. The electron density surface with large values of the density are called “bond 
density” surfaces. We can use the “bond density” surface for HF, H2¸and LiH to compare the bonding in the three 
molecules. Note the characteristics and sketch this electron density surface. Record any observations that you 
have for each surface. For example, where are the electrons localized? What is the size of the bond density 
surface around each atom? What is the size of the electron density along the internuclear axis between the 
two nuclei. Do the density surfaces show a big difference in covalent or ionic character for the molecules? 
 

 
 

Click on “Default” button, then “Apply” button before continuing. 

Electron Density Surface Settings for 
“Bond Density” Visualization 
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12)  Using Electrostatic Potential Surfaces to Compare the Polarity of HF, H2, and LiH:  To see the electrostatic 
potential surface, click “Electrostatic potential” button in the MO Viewer. The red color corresponds to regions 
where the positive test charge is attracted to the surface giving a negative energy, in other words a region of high 
electron density and net negative local charge. The blue regions correspond to areas with low electron density and 
net positive local charge. Record any observations that you have for each surface. For example, where are the 
electrons localized? Is the charge distribution the same as your prediction based on electronegativity? 
 

13)  The ESP (electrostatic potential) surfaces can be used to compare the polarity of HF, H2¸ and LiH. The MO 
Viewer by default chooses the color scale. For a fair comparison, plot the ESP with a consistent potential range for 
the colors for each molecule. First create ESP surface for each molecule with a fixed potential range and copy each 
rendering to one Word document so that all three may be directly compared. 
   In the “Preferences” window, click on the “Colors” tab. Click on the checkmark for “Auto scale range” option. 
Then change the “Mapped values”  to -0.12    0.37   . 
 

 
 

   Click on the “Copy image to clipboard”  icon in the top icon bar of the MO Viewer window. Paste the 
clipboard into a Word document so that you can compare HF, H2, and LiH directly.  
 

14) Return to the WebMO Job Manager by clicking on the blue right arrow. 
 

 
 

 
 
PART II:  In this exercise we will investigate the molecular orbitals for diatomic oxygen and NO, and the 
molecular structure of ozone.  
 
Building O2 
 

1)  Build O2: Following step 1, above, build and minimize O2. Drag twice between the two atoms to make a double 
bond. You should now have two red colored oxygens that are double bonded. Continue as you did for HF (step 1-5) 
but specify the “Multiplicity” as triplet. 
 

2)  Determine the Bond Order:  View the molecule and then click on the “New Job Using this Geometry” button. 
Then click on the blue right arrow button twice to view the Configure Gaussian Job Options window. Enter a job 
name and choose the following options:  
 Calculation: Bond Orders 
 Theory: Hartree-Fock 
 Basis Set: Routine: 6-31G(d) 
 Charge: 0 
 Multiplicity: Triplet 
 

Continue following steps 3-5 from Section 1. Scroll down in the View Job window to the Bond Order section. 
Record the bond order. 
 

3)  Generate the Molecular Orbitals for O2:  Click on the “New Job Using this Geometry” button. Then click on the 
blue right arrow button twice to view the “Configure Gaussian Job Options” window. Enter a job name and choose 
the following options:  

Electrostatic Potential Settings for 
Comparing HF, H2, and LiH 
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 Calculation: Molecular Orbitals 
 Theory: Hartree-Fock 
 Basis Set: Routine: 6-31G(d) 
 Charge: 0 
 Multiplicity: Triplet 
 

Continue following steps 3-5 from Part I. 
 

4)  View the Molecular Orbitals:  Scroll down in the View Job window to the section that lists the molecular orbital 
energies. Click on the magnifying glass adjacent to the highest energy occupied molecular orbital (as shown below). 
(The occupancies are all listed as 1 because for molecules with unpaired electrons, only the “up”, “↑” electrons are 
shown.) 
 

 
 

5)  The “Molecule Viewer” will switch to the “Molecular Orbital Viewer” mode, at the top of the page. The 
molecular orbital that you chose will be displayed. You can reorient the orbital using the mouse. You can choose 
any other molecular orbital from the “Molecular Orbital Viewer” (you don’t need to go back to the bottom of the 
View Job page). Select the LUMO from the MO list at the left side of the “Molecular Orbital Viewer” window. 
Notice that when you choose a new orbital from the list at the left, the current plot is saved as a tab at the top of the 
“Molecular Orbital Viewer” window. After the first time that you view an orbital, you should return to that plot 
using the tabs at the top of the “Viewer” window. Record any observations that you have for each molecular 
orbital. For example, where are the electrons localized? For the HOMO and LUMO, are they sigma or pi 
type, bonding or anti-bonding? 
 

6) Return to the WebMO Job Manager by clicking on the blue right arrow. 
 
The Bonding in NO 
 

1)  Now build NO using the same steps as we used for O2. Depending on the bond type that you specify, the normal 
“Comprehensive-Mechanics” method might add a hydrogen atom to the structure. Instead, for the “Clean-Up” step, 
pull down the “Clean-Up” menu, and slide right on “Mechanics”, and then choose “Optimize”. Remember to set the 
“Multiplicity” as doublet. 
2)  Determine the bond order and sketch the LUMO and HOMO views. 
 
 
If you have completed the Supplemental Report Sheet  and had it checked by the lab instructor you are now 
done with the WebMO program.  
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Highest Occupied Molecular Orbital 


